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Penyediaan Storyboard 

a. Turutan isi kandungan persembahan / jalan cerita untuk video yang akan 

dihasilkan 

b. Merangkumi 

i. Intro 

ii. Isi  

iii. Penutup 

Cth 1: 

Intro Video  

 Image : Logo Kementerian 

 Image : Logo Sekolah 

 Text : Tajuk 

 Text : Kategori SLAAS 

Pengenalan 

 Text : Pengenalan mengenai sekolah 

Komponen Pengurusan 

 Text : Organisasi Pelaksanaan SLAAS 

 Image & Text : Tempat Buang Sampah 

 Image & Text : Sistem Pembangunan Tempat Alam Sekitar 

Komponen Penghijauan 

 Image & Text : Rekabentuk Taman 

 Image & Text : Sistem Pengumpulan Air Hujan 

 Image & Text : Taman Herba 

Komponen Kurikulum 

 Image & Text : Penjimatan Air/Elektrik 

 Image & Text : Pembelajaran dan Pengajaran 

Komponen Kokurikulum 

 Image & Text : Aktiviti Gotong Royong 

 Image & Text : Kelab Alam Sekitar 

Elemen Khas 

 Image & Text : Projek Rawatan Air Sisa 

Penutup 

 Text : Kesimpulan 

 Text : Impak kepada Sekolah, Komuniti dll 

 Text : Harapan Menyertai SLAAS 
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Cth 2 : 
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Pengambilan gambar / video menggunakan Telefon 

Pintar 
 

a. Keupayaan telefon pintar : kamera 3MP dan ke atas (minima) 

b. Aplikasi yang digunakan : standard aplikasi camera (minima) 

c. Ruang simpanan telefon / kad memori mencukupi 

 

Sebelum Pengambilan Gambar / Video  
Setting Kamera di Telefon Pintar 

 Camera Frame – Full Screen 16:9 (Horizontal) 

 Kualiti Gambar – “High/Best” 

 Set telefon kepada Airplane Mode semasa pengambilan video 

 

Standard Format   

i. Gambar –  .jpg 

ii. Video – .MP4 

 

Semasa Pengambilan Gambar / Video  
 Orientation : Landscape 

Tips: 

- Fokuskan pada objek untuk elak gambar blur (sentuh pada objek di skrin 

untuk tentukan titik fokus) 

- Boleh guna feature Scene Mode untuk fungsi tambahan cth : Potrait, 

Landscape, Night, Backlight dll 

- Pastikan cukup pengcahayaan. Elakkan menggunakan flash untuk 

mengelakkan background menjadi gelap 

- Elakkan menggunakan front camera kerana kualiti kurang baik 
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Penyimpanan Gambar / Video 
 Simpan gambar / video / input lain mengikut storyboard yang dibuat 

Cth: 
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Penyediaan Video  

Software – Free  & Berbayar 

i. Free – cth: Powerpoint, Windows Movie Maker 

ii. Berbayar – cth: Adobe Premiere, Proshow Producer 

 

Penyediaan video menggunakan Ms PowerPoint 

 Menggunakan Ms PowerPoint 2010 dan keatas sahaja. Ms PowerPoint 2007 

tiada fungsi Save as /Export ke Video 

 Durasi video 3 – 5 minit sahaja 

a. Orientation - Potrait / Landscape 

b. Ratio - 16:9 

c. Masukkan gambar / video / text 

d. Susun gambar / video mengikut storyboard 

e. Edit Slaid 

i. letak transition (jika perlu) 

ii. letak animation (jika perlu) 

iii. tukar font (jika perlu) 

 Download free font : https://fonts.google.com/ 

iv. tambah audio 

 

Video recommendations 

PowerPoint 2010: .wmv 

PowerPoint 2013, PowerPoint 2016: .mp4 

Audio recommendations 

PowerPoint 2010: .wav, .wma 

PowerPoint 2013, PowerPoint 2016: .m4a files  
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Video 
 

Supported Video File Formats 

 

 Supported video file formats for Windows 

File Format Extension 

Windows Video file (Some .avi files may require additional 

codecs) 

.asf 

Windows Video file (Some .avi files may require additional 

codecs) 

.avi 

MP4 Video file* .mp4, .m4v, .mov 

Movie file .mpg or .mpeg 

Adobe Flash Media** .swf 

Windows Media Video file .wmv 

*Only PowerPoint 2013 and later. The 32-bit version of PowerPoint 2010 can play an .mp4 or 

.mov file only if the computer has a QuickTime Player installed.  

 

 Supported video file formats for Android 

File Format Extension 

MP4 Video file .mp4, .3gp, .ts 

VP8, VP9 .webm, .mkv 
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Tambah Video (Ms PowerPoint 2010) 

1. In Normal view, click the slide in which you want to embed the video. 

2. On the Insert tab, in the Media group, click the arrow under Video. 

3. Select Video from file, and then browse to the location of your video, and 

select it. 

4. On the Insert button, click the down arrow, and then click Insert. 

 

Tambah Video (Ms PowerPoint 2013) 

1. In Normal view, click the slide that you want the video to be in. 

2. On the Insert tab, click the arrow under Video, and then click Video on My 

PC. 

3. In the Insert Video box, click the video that you want, and then click Insert. 

 

Tambah Video (Ms PowerPoint 2016) 

1. In Normal view, click the slide that you want the video to be in. 

2. On the Insert tab, click the arrow under Video, and then click Video on My 

PC. 

3. In the Insert Video box, click the video that you want, and then click Insert. 
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Edit Video 
 Menggunakan (Ms PowerPoint 2010) 

 Menggunakan (Ms PowerPoint 2013) 

 Menggunakan (Ms PowerPoint 2016) 

Edit Video (MS PowerPoint 2010) 

 

To resize the video: 

1. Select the video. A box with resizing handles will appear around the video. 

2. Click and drag any of the handles to resize the video. 

 

Editing and formatting videos 

The Playback tab has several options you can use to edit your video. For example, you 

can trim your video so it will only play an excerpt, add a fade in and fade out, and 

add bookmarks that allow you to jump to specific points in the video. 

Most of the features on the Playback tab can only be used with videos that are inserted 

from a file. They will not work with embedded videos. 

To trim the video: 

1. From the Playback tab, click the Trim Video command. The Trim Video dialog box 

will appear. 

 

Use the green and red handles to set the start and end times. 
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2. To preview the video file, click the Play button. 

 

3. Adjust the green and red handles again if necessary, then click OK. 

To add a fade in and fade out: 

1. On the Playback tab, locate the Fade In and Fade Out fields. 

2. Type the desired values, or use the up and down arrows to adjust the times. 

 

Video options 

There are other options you can set to control how your video plays. These are found in 

the Video Options group on the Playback tab. 
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 Volume: This changes the audio volume in the video. 

 Start: This controls whether the video file starts automatically or when the mouse 

is clicked. 

 Play Full Screen: This lets the video fill the entire screen while it's playing. 

 Hide While Not Playing: This hides the video when it's not playing. 

 Loop Until Stopped: This causes the video to repeat until it is stopped. 

 Rewind After Playing: This causes the video to return to the beginning when it's 

finished playing. 
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Edit Video (MS PowerPoint 2013) 

To resize a video: 

 Click and drag the corner sizing handles until the video is the desired size. 

 

The corner sizing handles will resize a video while preserving its original aspect ratio. If 

you use the side sizing handles, the video will become distorted. 

To move a video: 

 Click and drag to move a video to a new location on a slide. 
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To delete a video: 

 Select the video you want to delete, then press the Backspace or Delete key on 

your keyboard. 

Editing and formatting videos 

The Playback tab has several options you can use to edit your video. For example, you 

can trim your video to play an excerpt from the original, add a fade in and fade out, 

and add bookmarks that allow you to jump to specific points in the video. 

Most of the features on the Playback tab can only be used with videos that are 

inserted from a file. They will not work with embedded videos. 

To trim a video: 

1. Select the video, then click the Playback tab on the Ribbon. 

 

 

2. Click the Trim Video command. 

 

 A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the endtime. 
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3. To preview the video, click the Play button. 

 

4. When you're done trimming the video, click OK. 

To add a fade in and fade out: 

1. On the Playback tab, locate the Fade In: and Fade Out: fields. 

2. Type the desired values, or use the up and down arrows to adjust the fade 

times. 

 

Video options 

There are other options you can set to control how your video will play. These are 

found in the Video Optionsgroup on the Playback tab. 
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 Volume: Changes the audio volume for the video 

 Start: Controls whether the video starts automatically or when the mouse 

is clicked 

 Play Full Screen: Lets the video fill the entire screen while playing 

 Hide While Not Playing: Hides the video when not playing 

 Loop until Stopped: Replays the video until stopped 

 Rewind after Playing: Returns the video to the beginning when it is finished 

playing 
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Edit Video (Ms PowerPoint 2016) 

 

To resize a video: 

 Click and drag the corner sizing handles until the video is the desired size. 

 

The corner sizing handles will resize a video while preserving its original aspect ratio. If you 

use the side sizing handles, the video will become distorted. 

To move a video: 

 Click and drag to move a video to a new location on a slide. 

 

To delete a video: 

 Select the video you want to delete, then press the Backspace or Delete key on 

your keyboard. 

Editing and formatting videos 
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The Playback tab has several options you can use to edit your video. For example, you 

can trim your video to play an excerpt from the original, add a fade in and fade out, 

and add bookmarks that allow you to jump to specific points in the video. 

Most of the features on the Playback tab can only be used with videos that are 

inserted from a file. They will not work with embedded videos. 

To trim a video: 

1. Select the video, then click the Playback tab on the Ribbon. 

2. Click the Trim Video command. 

 

3. A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the end time. 

 

To preview the video, click the Play button. 
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4. When you're done trimming the video, click OK. 

To add a fade in and fade out: 

1. On the Playback tab, locate the Fade In: and Fade Out: fields. 

2. Type the desired values, or use the up and down arrows to adjust the fade times. 

 

Video options 

There are other options you can set to control how your video will play. These are 

found in the Video Options group on the Playback tab. 

 

 Volume: Changes the audio volume for the video 

 Start: Controls whether the video starts automatically or when the mouse 

is clicked 

 Play Full Screen: Lets the video fill the entire screen while playing 

 Hide While Not Playing: Hides the video when not playing 

 Loop until Stopped: Replays the video until stopped 

 Rewind after Playing: Returns the video to the beginning when it is finished 

playing 

  



Penghasilan Video Menggunakan Ms PowerPoint 

 

Kembali ke Isi Kandungan 19 

Audio 
 

Supported Audio File Formats 

 Supported audio file formats for Windows 

File format Extension 

AIFF Audio file .aiff 

AU Audio file .au 

MIDI file .mid or .midi 

MP3 Audio file .mp3 

Advanced Audio Coding - MPEG-4 Audio file* .m4a, .mp4 

Windows Audio file .wav 

Windows Media Audio file .wma 

*Only PowerPoint 2013 and later. The 32-bit version of PowerPoint 2010 can only play an 

.mp4 or .mov file if the computer has a QuickTime Player installed.  

 

 Supported audio file formats for Android 

File format Extension 

MP3 Audio file .mp3 

Advanced Audio Coding - MPEG-4 Audio file .m4a, .mp4, .3gp, .ts, 

.aac 

MIDI (Musical Instrument Digital Interface) .mid, .xmf, .mxmf, 

.rtttl, .rtx, .ota, .imy 

FLAC (Free Lossless Audio Codec) .flac 

Open source .mkv, .ogg 
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Tambah Audio 

  

i. From the Insert tab, click the Audio drop-down arrow and select Audio 

from File. 

 

ii. Locate and select the desired audio file, then click Insert. 

 

iii. The audio file will be added to the slide. 
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Edit Audio 
i. Menggunakan Ms PowerPoint 2010 

ii. Menggunakan Ms PowerPoint 2013 

iii. Menggunakan Ms PowerPoint 2016 

 

Edit Audio (Ms PowerPoint 2010) 

 

1. From the Playback tab, click the Trim Audio command. The Trim Audio dialog box 

will appear. 

 

2. Use the green and red handles to set the start time and end time. 

 

3. To preview the audio file, click the Play button. 

 

4. Adjust the green and red handles again if necessary, then click OK. 

To add a fade in and fade out: 

5. On the Playback tab, locate the Fade In and Fade Out fields. 

6. Type in the desired values, or use the up and down arrows to adjust the times. 
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Audio options 

There are other options you can set to control how your audio file plays. These are 

found in the Audio Options group on the Playback tab. 

 

 Volume: This changes the audio volume. 

 Start: This controls whether the audio file starts automatically or when the mouse 

is clicked. 

 Hide During Show: This hides the audio icon while the slide show is playing. 

 Loop Until Stopped: This causes the audio file to repeat until it is stopped. 

 Rewind After Playing: This causes the audio file to return to the beginning when 

it's finished playing. 

 



Penghasilan Video Menggunakan Ms PowerPoint 

 

Kembali ke Isi Kandungan 23 

Edit Audio (Ms PowerPoint 2013) 

 

1. Select the audio file, then click the Playback tab on the Ribbon. 

 

2. Click the Trim Audio command. 

 

3. A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the endtime. 

 

4. To preview the audio file, click the Play button. 

 

5. Adjust the handles again if necessary, then click OK. 

To add a fade in and fade out: 

1. On the Playback tab, locate the Fade In: and Fade Out: fields. 

6. Type the desired values, or use the up and down arrows to adjust the times. 
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Audio options 

There are other options you can set to control how your audio file will play. These are 

found in the Audio Options group on the Playback tab. 

 

 Volume: Changes the audio volume 

 Start: Controls whether the audio file starts automatically or when the mouse 

is clicked 

 Hide During Show: Hides the audio icon while the slide show is playing 

 Play Across Slides: Continues playing the audio file across multiple slides instead of 

just the current slide 

 Loop until Stopped: Replays the audio file until stopped 

 Rewind after Playing: Returns the audio file to the beginning when it is finished 

playing 
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Edit Audio (Ms PowerPoint 2016) 

 

1. Select the audio file, then click the Playback tab on the Ribbon. 

 

2. Click the Trim Audio command. 

 

3. A dialog box will appear. Use the green handle to set the start time and 

the red handle to set the end time. 

 

4. To preview the audio file, click the Play button. 

 

5. Adjust the handles again if necessary, then click OK. 
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To add a fade in and fade out: 

1. On the Playback tab, locate the Fade In: and Fade Out: fields. 

2. Type the desired values, or use the up and down arrows to adjust the times. 

 

Audio options 

There are other options you can set to control how your audio file will play. These 

are found in the Audio Options group on the Playback tab. 

 

 Volume: Changes the audio volume 

 Start: Controls whether the audio file starts automatically or when the mouse 

is clicked 

 Hide During Show: Hides the audio icon while the slide show is playing 

 Play Across Slides: Continues playing the audio file across multiple slides 

instead of just the current slide 

 Loop until Stopped: Replays the audio file until stopped 

 Rewind after Playing: Returns the audio file to the beginning when it is 

finished playing 
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Export Slaid ke Video 
 

i. Format .mp4 atau .wmv 

ii. Resolusi  

a. Video HD  - 720p (1280 x 720 pixel resolution) 

b. Video Full HD – 1080p (1920 x 1080 pixel resolution) 

Langkah-Langkah: 

 MS PowerPoint 2010 

 MS PowerPoint 2013 

 MS PowerPoint 2016 
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Export Slaid ke Video (Ms PowerPoint 2010) 

 

1. Select the File menu and click on Save & Send.

 

2. Under the Save & Send menu, find and click on Create a Video.

 

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2010_3.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2010_4.png
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3. Click on the Computer & HD Displaysoption to customise the video size and 

quality (small, medium and large size & quality).

 

4. Click the Don’t Use Recorded Timings and Narrations  to select if you’re using 

timings and narrations. 

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2010_5.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2010_6.png
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5. Click Create Video and another dialogue box opens.

 

6. Enter appropriate filename and saving location to save your newly created 

video. 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2010_7.png
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Export Slaid ke Video (MS PowerPoint 2013) 

 

1. Access Powerpoint’s Backstage View by clicking on File. 

 

2. Select Export and click on Create a Video to access the video export menu.

 

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_1.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_2.png
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3. Click on the Create a Video option and expand the Computer and HD 

Displays option to select output video size and quality settings.

 

4. Click on the drop down arrow to expand the Use Recorded Timings and 

Narrations menu. Use this to select whether you’re using recorded timings or 

not. If not using recorded timings and narrations, set the duration of each slide 

using the timings option at the bottom.

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_3.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_4.png
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5. Click the Create Video button to show the Save As dialogue box.

 

6. Select the location where you want to save your video and choose a suitable 

filename for the video file. Also choose the video file type.

 

7. Click Save and PowerPoint will begin converting your presentation to video. This 

may take a couple of seconds or a few minutes depending on the size of  

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_5.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_6.png
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8. your presentation.

 

 

  

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2013_7.png
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Export Slaid ke Video (MS PowerPoint 2016) 

 

1. Click on the File tab to show file options. 

 

2. Scroll down and select Export and navigate to Create a Video.

 

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2016_1.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2016_2.png
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3. Select your video settings preference (video quality, timings and narration, video 

size).

 

4. Click on Create a Video.

 

 

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2016_3.png
https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2016_4.png
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5. Choose a filename, saving location and video type (.mp4 or .wmv).

 

6. Click on Save to start video creation process. 

 

  

https://24slides.com/presentbetter/wp-content/uploads/2016/10/PPT-to-Video-2016_5.png
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Proses Kerja Penghantaran Video 
 

  

Sekolah

•Wujudkan akaun gmail

•Upload video+template dalam google drive & facebook

•Copy link

•Emel ke Urusetia SLAAS Negeri

Urusetia 
SLAAS Negeri

•Buka link google drive yang dihantar oleh sekolah

•Download dan simpan di dalam PC

•Proses Penilaian & dapatkan laporan dari sekolah terpilih

•Upload video+laporan+template dalam google drive 

•Emel link video SLAAS+laporan+template sekolah terpilih ke akaun gmail Urusetia SLAAS HQ

Urusetia 
SLAAS HQ

•Buka link google drive yang dihantar oleh Urusetia SLAAS Negeri

•Download dan simpan di dalam PC

•Penilaian oleh Juri Kebangsaan
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Penghantaran video (Google Drive) 

i. Wujudkan akaun gmail (jika belum ada) 

ii. Log in akaun gmail 

iii. Hantar video menggunakan google drive 

 

Wujudkan akaun Gmail 
 

1. Go to www.gmail.com. 

2. Click Create account. 

 

3. The signup form will appear. Follow the directions and enter the required 

information. 

  

 

Format 

First Name: slaas 

Last Name : [negeri] cth : Kelantan 

Username : slaaskelantan 

http://www.gmail.com/
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4. Review Google's Terms of Service and Privacy Policy, click the check box, then 

click Next step. 

 

5. Here, you'll have an opportunity to set up recovery options. Recovery options are 

helpful if you forget your password or if someone tries to access your account. If 

you don't want to set up recovery options at this time, click Done. 

 

6. Your account will be created, and the Google welcome page will appear. 

 

 

http://www.google.com/intl/en/policies/terms/
http://www.google.com/intl/en/policies/privacy/
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Just like with any online service, it's important to choose a strong password—in other 

words, one that is difficult for someone else to guess. For more information, check out 

our Creating Strong Passwords lesson. 

 

 

  

http://www.gcflearnfree.org/internetsafety/creating-strong-passwords/1/
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Login ke akaun Gmail 
 

1. First, access to gmail website: gmail.com or you can click here to access quickly. 

2. Then, you can see the interface where you can enter your email address and 

password. Please enter your email address in the first line of the interface, you must 

use the email address you have selected during the creating of your account. 

3. Next, Enter the password you have used at your registration in the second line. 

Please make sure that you enter the right password that belongs to the entered e-

mail address. 

4. Finally, Are you sure that you've entered both your e-mail address and password? 

Then click the blue Sign in button. 

5. Congratulations, you have now successfully signed in to your account. 

6. You can use 2-step verification so that your Gmail account will be better secured. 

7. Note: When logging in, you can also choose whether Google needs to remember 

your password for you or not. If you choose yes, it will automatically save your 

password, and you don’t have to enter it again when you visit your e-mail the next 

times.  

  

https://gmail.com/
https://gmail.com/
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Hantar video menggunakan google drive 
  

Step 1: Go to drive.google.com 

On your computer, go to drive.google.com. You’ll see "My Drive," which has: 

 Files and folders you upload 

Step 2: Upload or create files 

Drag files into Google Drive 

1. On your computer, go to drive.google.com. 

2. Open or create a folder. 

3. To upload files and folders, drag them into the Google Drive folder. 

Step 3: Share and organize files 

You can share files or folders, so other people can view, edit, or comment on them. 

a. Choose who to share with; 

 Specific people 

Like files, you can choose to share with only specific people. 

1. On your computer, go to drive.google.com. 

2. Click the folder you want to share. 

3. Click Share . 

4. Under "People," type the email address or Google Group you want to 

share with. 

5. To choose how a person can use the folder, click the Down arrow . 

6. Click Send. An email is sent to people you shared with. 

https://drive.google.com/
https://drive.google.com/
https://drive.google.com/
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 Anyone with a link to the folder 

You can give other people a link to your folder so that you don't have to add 

email addresses when you share your folder. 

1. On your computer, go to drive.google.com. 

2. Click the folder you want to share. 

3. Click Share . 

4. At the top right, click Get shareable link. 

5. Next to "Anyone with the link," click the Down arrow . 

6. Choose whether people can edit or view. 

7. Copy and paste the link in an email or any place you want to share it. 

b. Change sharing permissions of shared folders 

Edit, comment, or view shared files 

When you share a folder, the sharing settings for the files and subfolders inside 

are updated. Depending on how you shared the folder, the people you 

shared with will have access to the files inside: 

 Can organize, add, & edit: People can open, edit, delete, or move any 

files within the folder. People can also add files to the folder. 

 Can view only: People can see the folder and they can open all files 

within the folder. 

After you share the folder, you can change how the files inside are shared. 

 

Nota : Sebelum hantar kepada urusetia, semak hyperlink/URL tersebut 

https://drive.google.com/
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